
Verisurf LPT   1 

 

 
Verisurf LPTREV A2 

 
TABLE OF CONTENTS 

VERISURF LPT INTRODUCTION 3 
THE VERISURF LPT PARTNERSHIP ............................................................... 3 
NETWORK CONNECTION ................................................................................ 4 

ADMIN / OPERATOR on LPT computer ...........................................................4 

SETTING UP LPT 7 
ADMINISTRATOR DATABASE SETUP .............................................................. 7 

User Security.....................................................................................................9 

CREATING A JOB 10 
CHOOSING A LASER AND LASER GROUP ..................................................... 10 
CHOOSING A PARAMETER SET..................................................................... 12 
ADDING TO THE JOBS TAB ........................................................................... 13 
VERISURF TO OBTAIN TOOL AND PART INFO .............................................. 15 
LPT LINKER ................................................................................................. 17 

Gathering Tool Points .....................................................................................18 
Gathering Curves ............................................................................................19 

CREATE THE JOB .......................................................................................... 20 
OPERATOR SOCKET CONNECTION SETUP ................................................... 21 

VERISURF/LPT INTERFACE EXAMINED 22 
TOOLING POINTS.......................................................................................... 22 

Naming............................................................................................................22 
Use Point Selection.........................................................................................23 
Tooling Points .................................................................................................23 

CHAIN CONTOUR.......................................................................................... 25 
Chain Method..................................................................................................25 
Controls...........................................................................................................28 
Saves ..............................................................................................................29 

CROSS HAIRS ................................................................................................ 31 
Type of Cross Hair ..........................................................................................31 

 

Copyright © 2006 Verisurf Software, Inc. All rights reserved.

 



Verisurf LPT   2 

MEASURE ...................................................................................................... 33 

USING VERISURF AUTOMATE WITH LPT10 34 
AUTOMATE INTERFACE - FEATURES ........................................................... 35 

Scanning Holes – Single Hole.........................................................................36 
Scanning Holes – Holes..................................................................................37 
Scanning Edges – Splines, Lines Arcs............................................................38 
Scanning Edges – Perpendicular to Hole........................................................39 

AUTOMATE INTERFACE – OPERATIONS MGR............................................ 40 
The Feature Tree ............................................................................................40 
Nominals Tab..................................................................................................41 
Tolerance Tab.................................................................................................43 

AUTOMATE INTERFACE – CONSTRUCT........................................................ 44 
Constructs.......................................................................................................44 

VERISURF > INSPECT 45 
PREPARATION PRIOR TO RUNNING PROGRAM ............................................. 45 

LPT OPERATOR ALIGN.................................................................................45 
LPT LINKER....................................................................................................45 

 

Copyright © 2006 Verisurf Software, Inc. All rights reserved.

 



Verisurf LPT   3 

 Verisurf LPT Introduction 
This manual was created to begin the bridge between Verisurf software and LPT 
software. It is a 1st draft and will be updated as the 2 softwares merge together. 
Any references in this manual to the LPT software functions in Administrator or 
Operator may be brief due to the fact that the LPT manuals on those topics can be 
used to reference all LPT functionality. Please refer to the LPT manuals for 
reference information on Administrator or Operator. 

The Verisurf LPT Partnership 
LPT and Verisurf Software, Inc. began a partnership in late 2005 that both 
companies felt would aid each other in becoming the world leader in laser 
projection. Prior to this partnership no company could efficiently project 3D curves 
onto a 3D surface. Due to this partnership LPT / Verisurf hardware and software 
have taken 3D projection to new heights with the ease of use and quality of 
projection.  
 
Using LPT / Verisurf hardware and software a customer can quickly project any 
type of curve accurately. This partnership has taken root at many companies 
requiring efficient and accurate projection and we are currently working with many 
customers to improve both the hardware and software to accommodate any 
customer need.  
 
LPT / Verisurf hardware and software are committed to the success of this joint 
venture and look forward to assiting your company in its projection requirements. 
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Network Connection 

ADMIN / OPERATOR on LPT computer 
 
There are no special connections involved. Once the projector is mounted in 
position, connect all of the necessary cables to the LPT1 rear panel. This example 
shows the connections for an LPT1. For other LPT models please refer to the 
Operator Manual for your particular LPT.  
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ADMIN and/or OPERATOR on Laptop 
 
To use the projector we need to adjust our 
network settings to be able to communicate 
between your computer and the projectors. 
 
You should have a desktop icon to be able to go 
to My Network Places > View Network 
Connections > Local Area Connection.  
From here go to Internet Protocol and double-
click. 
 
 
 
 
 
 
 
 
 
 
 
 
 
This will bring up a screen that you can input an IP 
address. 
 
Input the address 192.168.0.15. Hitting tab after 
the IP address will automatically enter the Subnet 
mask 255.255.255.0.  
 
Once this is accomplished your computer with 
Verisurf should be able to communicate with the 
projector. 
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On rare occasion you may not get a connection. To test this we can “PING” the 
connection. Use START > RUN and type CMD. This will bring up a command 
prompt or DOS prompt. From here type ping 192.168.0.15. A report will be given 
showing whether the computer is “talking” with the projector. This screenshot that 
the computer is talking with the projector. We see this because we are receiving a 
Reply. 
 

 
 
If the “PING” fails you will need to double-check a few items. 
 

• Double-check your IP address. 
• Double check your cabling. 
• Do you have a firewall? This may prevent the IP address being recognized. 

 
After checking these items you should obtain a connection and be able to log into 
the LPT computer. 
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Setting up LPT  
Administrator Database Setup 
 
 
Double clicking the icon to the right will bring up the Ray 
Tracer Administrator Login screen shown below. 
 
 
 
 
The the Ray Tracer Administrator Login screen is where we will set-up a new 
database or load an existing database. 
 

 
 
Choosing File at the top left will open this menu. Her we see we can create a new 
database, open an existing database or choose a prior database from history. 
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Choosing NEW will prompt if indeed you want to create a NEW database and then 
take you to this screen prompting where you want the database files to be located. 
Being a NEW database we will create a new folder choosing Create new folder 
from the icon at the upper right.  
 
In this example a new folder named CDS has been created and then we double-
clicked to enter the database. The filename is Users.xml. We save this and we now 
have a new database with individual files that are currently empty. 
 
 

 
 
Once the Administrator Main menu is active we can see 5 pulldowns and 7 tabs. 
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User Security 
 
Once we have a database created through administrator it is advisable to create a 
new account that is easy to remember. We do this through the options pulldown > 
User Security.  
 

 
 
Shown here we have the initial User 
Security setting with only the 
administrator shown as a user. We will 
add another User ID and password 
with FULL access so that we can 
easily get in and out of this database. 
At Verisurf LPT we usually use User 
ID “m” and password “m”.  
 
 
Type those letters in the entry boxes 
and then to give this User ID full 
access we click the Security Level 
pulldown and choose 8 – override. 
 
 
 
 
 
 
 
 
 
 
Shown here is the new User ID M. 
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Creating a Job 
As an administrator you can create a job database that can then be sent to LPT 
Operator to run. A job consists of 4 databases that MUST be in the job and 
perhaps a clipping set database if using more than one Laser. The 4 that must be 
there are Laser Group, Parameter Set, Tools and Parts. The Administrator 
pulldowns are used to create Laser Group and Parameter set while Verisurf will be 
used to create Parts and Tools. 

Choosing a Laser and Laser Group 
  
The first item, Lasers / Laser Groups 
are created to tell the job which Laser 
it will connect to. 
 
Go to Tab named Laser and right-click 
in the field to bring up the menu shown 
to the right. You can then choose New 
and enter the exact Laser name. 
 

 
  
After creating the Laser name it will appear in the field. 
 

 
 
We can now create a Laser Group by right-clicking the Laser name and choosing 
New Laser Group. 
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Type in a name for the group and a new Laser group will be created that you can 
verify by choosing the Laser Groups tab. 
 

 
 
We now have 1 of 4 components needed to create a job. 
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Choosing a Parameter Set 

 
 
LPT comes with 2 parameter sets as defaults. They are English and Metric Default 
sets. These can be used as a basis to create your own customized parameter set 
for your application. 
Determine whether you will be working in English or Metric and create a copy that 
will be renamed. Right-click and choose New Copy and give it a new name. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once your Parameter set is created, we can modify it to suit your needs. 

 

Copyright © 2006 Verisurf Software, Inc. All rights reserved.

 



Verisurf LPT   13 

 

 
 
Page 27 of the LPT Administrator Manual contains all the variations we can use. 
Your instructor will go over the basics of the 3 pull-down tabs with you to set up an 
initial Parameter set. 
 
 

 

Adding to the Jobs Tab 
Now you can add the Laser Group and Parameter Set to your job. Click on the 
Jobs tab. Right-click and choose New, name the job and click OK. The Job 
Selection box will appear. Using the arrows in the middle, transfer the Laser over to 
the Laser Groups.  
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In the Job Parameters, select the new set from the dropdown menu. Display 
Date/Time Stamp should be the only item checked. Click on the Save icon. Close 
the window and minimize Administrator. 
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Verisurf to obtain Tool and Part Info 
 
Double clicking the icon to the right will bring up the Verisurf that 
you can use to gather your tooling points and part geometry. Go to 
File>Open and get the .MC9 file you wish to work on. 
 
 
Once the job is opened in Verisurf, we will start the LPT 
functionality by clicking the icon to the right. This icon may or may 
not be on your icon toolbar. If it is not access it by hitting ALT-C a
choosing LPT.dll as shown below. 

nd 

 

 
 
Choosing LPT.dll or the icon will bring up LPT. From this menu we then start the 
LPT linker by choosing Start LPT Linker.  
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LPT Linker 
The LPT Linker is used to gather the Parts and Tool Points as you can see by the 
two tabs shown below. 
 

 
 
If running Operator from the Laptop we need to tell Linker which computer is 
running the Laser.  

  
 
Go to Network settings and change the Operator Host ID to your computer name.  
Check the enable Client LPT Network Control. This will enable your laptop to 
control the projector. 
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Gathering Tool Points 
 
Using the CAD tools available in Verisurf it becomes 
a simple process to gather tooling points.  You need 
a minimum of 4 points to align to. Ensure that the 
points cover as much area of the part as possible. 
Choosing new with “Use Point Selection” on will put 
you into the point selection menu to individually 
choose points, intersects, endpoints, etc. With “Use 
Point Selection” off you can window around a group 
of points to be used for creating tooling points.  
 
Using this tool we can easily load tooling points into 
the database that LPT operator can use.  
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Gathering Curves 
 
 
Using the Cad entities that are in the Verisurf Cad 
model we see that it becomes a relatively easy process 
to pick entities to project once there is an alignment. 
Clicking the Operation box toggle to Chain curves we 
get this menu (may need a new screenshot here due to 
updates in software programming)  
Once toggled we can choose various curves and load 
those curves into the database.  
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Create the Job 
Go to the Job tab of Administrator and right-click in the field to create a new job. 
Choose a name and the Job Selection menu will appear. Here we see the drop 
downs contain the 4 components we discussed. Tools, Parts, Laser Groups and 
Job Parameters should now have a database in the Available column that can be 
entered into the Selected column. 
 

 
 
Go through the first 3 tabs and place the databases you created from Available to 
Selected. The 4th tab, Job Parameters, has a new table that has a number of 
options. Set them as shown below choosing your Parameter set from the pulldown. 
These options are reviewed in the Administrator Manual.  
 

 
 
Choose SAVE on this menu and then SAVE the job. Congratulations! You have 
created your 1st Verisurf / LPT job. 
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Operator Socket Connection Setup 
We are now ready to begin filling the PART and TOOL database folders with data. 
We do this through the Verisurf interface but we first need a connection between 
Verisurf and Operator. We accomplish this by turning on a socket connection in 
RayTracer Operator. 
 
Double clicking the icon to the right will bring up the Ray Tracer 
Operatorr Login screen shown below.  
 
 
The Ray Tracer Operator Login screen is where we will log into a
database. Use the browse button to locate the database created in Administ
 

n existing 
rator. 

 
 

nce the Operator interface is opened we pull down Options > Socket Connection. 

e click on Start Listen and we should obtain a message that socket is open. 

O
 
W
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 Verisurf/LPt Interface Examined 
Tooling Points 
 
Tooling points, or retro-targets as they are 
known in most parts of the industry, are known 
value points in the model that the projector uses 
to align itself to the part. When these points are 
picked up by the projector the system uses the 
known locations to best-fit itself to the model. 
After this is accomplished we can then project 
any line, spline or arc in the model onto the part. 
 
Unlike most systems which only use reflective 
targets LPT projectors can also pick up either a 
edge intersection or a hole in the part and use 
these items for alignment. However, this can 
only be accomplished with the LPT 10 or the 
new LPT 100. For this discussion we will limit 
ourselves to retro-targets. Intersect and circle 
targets will be discussed if the user has 
purchased a LPT10 or LPT100. 
 

Naming 
 
The Naming section of the LPT 
interface contains two boxes labled 
Part and Layer / Ply. The default 
Part Name will be the name of the 
*.MC9 file your model is contained 
in. This corresponds to the name in 
the Linker that will be the program 
name. 
The Layer / Ply Name corresponds 
to the name in the Linker that will be 
the first branch of the tree. Under 
this branch are the actual points that 
will be used for alignment. 
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Use Point Selection 
 
 
 

 
 
With Use Point Selection toggled on Verisurf will give you 
the ability to individually choose points in the order you 
desire. It responds just like the normal Point Selection option 
available in many MasterCam functions. As your cursor 
hovers over a point it will lock onto that point and it can be 
selected. Continue selecting all points required to align and 
when finished choose the Back button or Escape. The points 
will load into the linker and the LPT Administrator. 
 
Having Use Point Selection toggled off Verisurf 
will give you the ability to either Window around all 
the points, choose All Points or selected a 
MasterCam Group of points. The benefit of this 
method comes into play if your model has been 
set up with some forethought. If your target points 
have notes associated with target names it is quite 
easy to choose Window and then window around 
all available targets and choose done. The points 
will load into the linker and the LPT Administrator. 
Caution: If other points are present in the model 
they will be included in the target set sent to the 
Linker.  
 
If all your target points are on one level you can 
choose ALL > Level and specify Level number. 
Choose Done and the points will load into the 
linker and the LPT Administrator.  
 

Tooling Points 
The Tooling Points we are working with are Retro-targets so that is the option 
selected. Also note that the Laser selected is set to NUMBER 1. This is the 
selection for one laser. If multiple projectors are being used use the pull-down and 
set this to which projector the tooling points apply to. The number corresponds to 
the order you have the projectors in your Laser Group that was set in Administrator.
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Chain Contour 
Chain Contour is where the real power of Verisurf / LPT is 
displayed. By choosing any single or group of lines, 
splines or arcs Verisurf will compute the laser path with 
your settings and send this path data to LPT to project 
real-time. The screen to the right shows the various 
settings you can adjust to send the path to the laser. 
Chain Method and Controls handles how the path will 
be sent while Saves enable an Administrator to visually 
analyze in the Cad what the path will look like. 

Chain Method 
There are 3 settings you can choose from that will 
determine the visual definition of the projection.  
 
Max Chord Height 
This setting allows you to set how tight the projection will 
be to the curve. It uses the chord length of any curve to 
determine where the projection points will be. With a tight 
setting of .002 (as shown) a point will be placed whenever 
the path along the curve finds a chord height of .002. 
Below is a 1.00 DIA circle projected at .002 Chord Height 
zoomed in to show the projection path. The straight line is 
the path zoomed in showing a chord length of .0019. This 
is under the max of .002.  
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The next picture shows the entire circle at .002 chord length. 
37 lines for the path and 36 lines for the projection points. 

 
 
Now lets look at a larger chord length of .010. 
It will have fewer points and lines and be less defined. 17 points and 16 lines. 
 

 
  
As we can see the definition is far better at a tight setting on chord length. You may 
ask, “why not always use a tight chord length?” Answer: This is only a 1.00 DIA 
circle and it would be fine. What is we had many curves to project in one ply? A 
tight setting would return hundreds , if not thousands, of points and lines that would 
need to be projected on one ply or level. This in turn will cause the projection to 
flicker. Breaking up the curves into separate entities may be required to get a 
projection at tight settings. 
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Distance Along 
This setting is pretty much self explanatory. 
Points and the distance between them will be 
spaced at what your setting is. These points 
are now at even increments of 0.1. We can see 
that it looks fine where the curve is a gradual 
radius but where the curve is sharp it misses 
part of the turn. Look at the lower-left corner for 
example. 
 

 
Num of Points 
This setting is pretty much self explanatory. 
This will limit the amount of points used to 
create the projection. With this setting only 200 
points will be used and they will be evenly 
distributed. 
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Controls 
These settings control a number of 
projection settings that may have to be 
used depending on your model integrity. 
There may be a case where what you want 
to project is not on the surface. Perhaps the 
lines you want to project need to be offset 
an inch to locate a mating piece. 
 
Max Num of Points 
This control is used to set a maximum number of points to project. With experience 
on your projector you will get a feel for how many points can be projected to limit 
the amount of flicker from your projector. The default is 20000 points. 
 
Project to Surface (Set to N – Normal) 
This control should be used if your splines to be projected DO NOT lie on the 
surface. The splines will then be projected NORMAL to the surface. Let’s have a 
look at an example. The picture below shows the spine curve we used on the prior 
page.Note how the curve projects NORMAL to the surface or “wraps”. 
 

 
Project to Surface (Set to V – View) 
The splines will then be projected NORMAL to the active CPLANE. This was 
projected in CPLANE TOP.  
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Surface Offset 
This setting can be used to offset the curves FROM the surface 
 

 
 
 
 
Range Envelope 
This setting is used for the operator to input the distance Verisurf will search for a 
surface to project to. I any part of the surface is further from the curve than the 
Envelope no path will be created in that area. 
 

Saves 
These settings were included in Verisurf to 
aid the Administrator in creating the 
projection paths prior to actually having 
the part to project on. Any of the choices 
can be selected to save, in the Cad 
model, points, vectors, paths and 
connection paths. Be careful that you 
save these entities to a different level as to 
not corrupt your model.  
 
Save Points in Verisurf 
Selecting this option will save the actual X,Y,Z laser point that the projector will be 
shooting to. These points will match what is written through the linker to the LPT 
part directory. Below is only the points being saved with normal projection. 
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Save Vectors in Verisurf 
 
Saving the vector lines from the points can enable the Administrator to visually 
check if the angle of the surface is too oblique to the projector. He can also verify 
that the vector direction is correct to assure that clipping will be used properly. 
Shown below are vector lines. Note: Vector lines are hard-coded to be 1.00 inches. 

 
 
Save Laser Path in Verisurf 
 
This control can be used so that the actual path that will be projected is displayed. 
The examples above show many saved laser paths. 
   
Save Connection Path 
This control can be utilized 
only if you are saving the 
laser path. It can then be 
checked to display a dashed 
line connection path 
between separate 
projections. This is useful to 
verify the laser path takes 
the shortest route between 
curves to minimize flicker.  
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Cross Hairs 
Cross Hairs are used to project locations of specific points. 
This is useful if you want to project rivet locations, tooling 
holes or any other location your application may require.  
The cross hairs can be projected in a combination of ways.  

Type of Cross Hair 
You have the choice of a 
single point, a cross hair with 
vertical and horizontal lines, a 
circle or square or a mixture or 
cross hair and circle/square.  
 
        CROSS HAIR 

 
 
  CROSS HAIR WITH CIRCLE            CROSS HAIR WITH SQUARE 
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Measure 
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Using Verisurf Automate with LPT10 
To use Verisurf Automate with LPT10 you will have to be licensed with Verisurf for 
the following modules: 

• LPT 
• Veriprobe 

Using the feature recognition tools of the LPT10 we can utilize Verisurf to create a 
program for measuring holes, edges and the dimensions between the holes and 
edges. A program can be written prior to the part being manufactured. When ready 
to inspect the new part you will need to align the LPT to the part and then run the 
pre-written program.  
For our example program we will use the part file shown below. The location of this 
file is LPT10_PROGRAMMING1.MC9. 
 It contains on separate levels, a surface, a series of points that represent holes, 4 
edge lines and a group of LPT targets with names. 
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Automate Interface - Features 
The LPT Automate interface is the identical to 
the normal Verisurf Automate interface except 
that there are subtle changes in the menus. To 
access the LPT automate we need to activate 
the LPT post processor. This is done through 
VERISURF > AUTOMATE > SETUP.  
 
 
 
 
 
On the tabs choose Post. Change the device to 
LPT. 
 

 
 
Now we are ready to program in Automate. 
There are 2 things that will be scanned. Holes and Edges. In holes we can choose 
either Single Hole to choose individually or Holes which will bring up the selection 
menu shown to the right.  
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Verisurf has provided two ways of collecting holes. Many customers use points 
placed on the surface to represent hole locations. Verisurf has allowed the user to 
select either holes (arcs) or points. When selecting them you can choose the points 
individually by using the Single Hole menu option or groups of holes by using the 
Holes menu option. 

Scanning Holes – Single Hole 
Let’s pick a few holes using both of these 
options. Open LPT10_PROGRAMMING1.MC9. 
We will pick H1 to H5 using Single Hole. 
 

1. Choose VERISURF > AUTOMATE > 
FEATURES > SINGLE HOLE. 

2. Using your cursor pick Hole 1. 
3. We see that Hole 2 is located right next to 

the representation of the surface. To 
choose it you can either choose below the 
point to assure that you are picking the 
point. You can ZOOM into the point to aid 
in picking it. You can also ALT-E > All 
POINTS to isolate the points. 

4. Continue picking Hole 3 through Hole 5. 
5. When you are finished picking the points 

choose ESC or BACKUP to end the 
selection.  

 
You will be shown this screen where you can 
input the Diameter to set your scanbox size.  
 
 

 
 

6. Change this to .25 and select OK. If you choose cancel your selections will 
be removed. 
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Scanning Holes – Holes 
To pick a group of holes of the same diameter the HOLES option is available. 
 
Choosing this option will bring up the selection menu shown below. 
 
The full selection menu is available, if you know it. 
Your primarily selection will be a window around 
points of similar diameter. 
 
Place a window around the points / arcs to be 
measured and choose done after your selection. 
 
 
 
 
 
AGAIN you will get the Hole Settings menu : 
 

 
 
Choose a diameter of your choice. 
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Scanning Edges – Splines, Lines Arcs 
Verisurf has provided two ways of collecting edges. We can manually “Sketch” on 
any line spline or arc. Verisurf will also allow you to pick any point and then Verisurf 
will find the closest edge. This closest edge is also perpendicular to the hole.  
 
 
 
 
 
This is an example of picking the edge points by 
sketching on the spline. 
 
 
 
 
 
 
At the time of the manual be created there are still some issues to be resolved 
when picking on a trimmed spline or picking while in different Cplanes. These 
problems will be resolved shortly. I have the best results by being in CPlane Top 
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Scanning Edges – Perpendicular to Hole 
 
Picking any point that represents a hole while in Edge will generate an edge scan 
at the closest line, spline or arc that it finds to the hole. 
 
 
 
 
 
This is an example of picking the edge points by 
picking the points and letting Verisurf determine the 
point perpendicular to the spline. 
 
 
 
 
 
 
 
 
You may run into occasions where the spline you want it to project perpendicular to 
is not the closest spline. You can SCREEN > BLANK the unwanted spline. Pick the 
point that will then project an edge to the correct spline. After this is done SCREEN 
> BLANK > UNBLANK the spline to bring it back. 
 
This perpendicular to hole option is really nice if you have a curved edge. Your 
edge scans will then be perpendicular  
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Automate Interface – Operations MGR 

The Feature Tree 
• The feature tree lists all the functions and features added by the operator 

during the course of creating the Automate Plan. Selecting a feature or 
function on the tree will cause the right side to expand as shown here. 

 
 

 

• 

 

 
• 

 
Features in the tree can als
 

 
 
 

Copyright © 20
Objects on the feature tree may be ‘Drag 
and Dropped’ as needed. For example if a 
feature needs to be added higher in the tree
simply add the feature to the bottom of the 
tree and drag it up to the desired location. 
Select OK. 

Features may also be moved down or 
deleted at any time. Select OK when edits 
o be renamed in the ID entry area shown below. 
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Nominals Tab 
 

• The Nominals Tab is completed automatically by the program as the 
modeled data is normally the product definition. 

 

 
 
• The report output can be adjusted by checking or un-checking the 

appropriate boxes here. The feature description, target origin and method of 
toleranceing may also be adjusted. 

 
• Checking the Position ν causes the output as True Position Dia., checking 

the MMC box will apply the Maximum Material Condition principle. 
 

• By using the dropdown boxes under ‘FROM’ the operator can specify from 
what feature the item is to be compared such as from Origin or from hole # 5 
etc... 
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• The X, Y and Z buttons to right of the ‘From’ column allow the operator a 
method to select features directly from the model as measure ‘From’ 
features. 

 
• Set Depth, Checking this option causes the playback to prompt for a point in 

the appropriate Axis to set the depth of projection. 
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Tolerance Tab 
 

• The Tolerance is completed by the operator based on blueprint or MBD 
toleranceing. 

 

 
 

• The applied tolerance can be adjusted here by checking or un-checking the 
appropriate boxes and modifying the parameters. 

 
• Checking the Position ν causes the output as True Position Dia., checking 

the MMC box will apply the Maximum Material Condition principle. 
 

• In this example True Position is the desired output so the toleranceing for 
the X and Y have been zeroed out. With these settings the report output will 
contain the actual as well as the positional results. 

 

 
  

• The X, Y and Z buttons to right of the ‘From’ column allow the operator a 
method to select features directly from the model as measure ‘From’ 
features. 

 
• Set Depth, Checking this option causes the playback to prompt for a point in 

the appropriate Axis to set the depth of projection. 
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Automate Interface – Construct 

                                       
 

Constructs 
• Distance, Angle, Mid Point, Intersect and Line allows the operator to pick 

two features to construct the 2D result between them. Each option presents 
this dialog box for the operator to pick the features to perform the function. 

 
 

 

Click on the drop down 
arrows will list the 
features in the database 
for selection. 

 

 
• When executing the construct commands the program def

entity from the model. By clicking on an entity or on the op
this menu to open. Here the operator can select items from
or return to the model for selection. Note the features sele
previously measured and on the tree for calculations to be
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Click on these 
numbered buttons will
present the model for 
manual entity 
selection.
aults to pick an 
en field will cause 
 the feature tree 
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 performed. 
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VERISURF > INSPECT 
Preparation prior to running program 

LPT OPERATOR ALIGN 
 
A job database with a valid tool.xml file must be used to align the part to be 
programmed and subsequently measured. This can be accomplished as outlined 
on Page 20, Tooling Points. Start OPERATOR and run the alignment tool file. 
 

LPT LINKER 
 
After the LPT10 is aligned to the tooling points 
we need to verify that LPT Linker in Verisurf is 
connected to LPT OPERATOR. 
 
Once the Operator interface is opened we pull 
down Options > Socket Connection. 
We click on Start Listen and we should obtain a 
message that socket is open. 
 
The LPT Linker is used to gather the Parts and Tool Points 
as you can see by the two tabs shown below. 
 
If running Operator from the Laptop we need to tell Linker 
which computer is running the Laser.  
  
 
Go to Network settings and change the Operator Host ID 
to your computer name.  
Check the enable Client LPT Network Control. This will 
enable your laptop to control the projector. 
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